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About Copyrights and Trademarks

Microsoft product screen shots are reprinted with permission from Microsoft Corporation.
Windows is a registered trademark of Microsoft Corporation in the United States and other
countries.

EtherCAT® is a patented technology and registered trademark licensed by Beckhoff Automation
GmbH, Germany.

Sysmac is a trademark or registered trademark of OMRON Corporation in Japan and other
countries for OMRON factory automation products.

Company names and product names in this document are trademarks or registered trademarks
of their respective companies.
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Related Manuals

To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for the devices that are used in the
system.

The following shows the manuals for OMRON Corporation (hereafter referred to as OMRON)
and Delta Tau Data Systems, Inc (DT).

Manufacturer | Manual No. Model Manual name

OMRON 1610-E1 Model CK3E-LIOIO Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W580-E1 Model NY510J-AJO0O | Industrial PC Platform NY-series IPC

Programmable Multi-Axis Controller
Hardware User’s Manual

OMRON W519-E1 Model NX-ECC203 NX-ECC201/ECC202/ECC203
EtherCAT® Coupler Unit User’s
Manual

OMRON W521-E1 Model NX-IDOIOOO NX-ID/IA/OC/OD/MD Digital I/O Unit

Model NX-ODOIOOO | User's Manual

DT 0014-E - Power PMAC User’s Manual

DT 0015-E - Power PMAC Software Reference
Manual

DT 0016-E - Power PMAC IDE Users Manual




2. Terms and Definitions

Term Explanation and Definition
Slave Slaves are devices connected to EtherCAT. There are various types of
slaves such as servo drivers handling position data and 1/O terminals
handling the bit signals.
Object Represents information such as in-slave data and parameters.
PDO One type of EtherCAT communications in which process data objects

communications
(Communications
using Process Data
Objects)

(PDOs) are used to exchange information cyclically and in realtime.
This is also called “process data communications”.

PDO Mapping The association of objects used for PDO communications.

PDO Entry PDO entries are the pointers to individual objects used for PDO
mapping.

ESI file An ESI file contains information unique to the EtherCAT slaves in XML

(EtherCAT Slave format.

Information file)

You can load ESI files into the EC-Engineer, to easily allocate slave
process data and make other settings.

ENI file
(EtherCAT Network
Information file)

An ENI file contains the network configuration information related to
EtherCAT slaves.

Power PMAC IDE

This computer software is used to configure the Controller, create user
programs, and monitor the programs.
PMAC is an acronym for Programmable Multi-Axis Controller.

Acontis
EC-Engineer

This computer software is used to configure the EtherCAT network and
each slave.




3. Precautions

(1) Understand the specifications of devices that are used in the system. Allow some margin
for ratings and performance. Provide safety measures, such as for installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrences.

(2) To ensure system safety, always read and follow the information provided in all Safety
Precautions and Precautions for Safe Use in the manuals for each device that is used in
the system.

(3) The user is encouraged to confirm the standards and regulations that the system must
conform to.

(4) It is prohibited to copy, reproduce, or distribute a part or the whole of this document
without the permission of OMRON Corporation.

(5) The information contained in this document is current as of July 2016.

It is subject to change without prior notice for improvement purposes.

The following notations are used in this document.

Indicates a potentially hazardous situation which, if not avoided,
may result in minor or moderate injury, or may result in serious
injury or death. Additionally, there may be severe property
damage.

/A WARNING

T C t Indicates a potentially hazardous situation which, if not avoided,
aution may result in minor or moderate injury, or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure correct operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operations easier.

Symbols

The filled circle symbol indicates operations that you must carry out.

The specific operation is shown in the circle and explained in text.

This example indicates a “general precaution” for something that you must
carry out.




Overview

This document describes the procedures used to connect the OMRON High EtherCAT
Coupler Unit model NX-ECC203 (hereafter referred to as the Slave) using OMRON
Programmable Multi-Axis Controller model CK3E-LOOL/NY510-ALOO (hereafter referred
to as the Controller) and EtherCAT, as well as for checking the connection.

Refer to Section 6. EtherCAT Connection Procedure to learn about the setting methods and
key points to perform PDO communications via EtherCAT.



5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices

The applicable devices are as follows:

Manufacturer Name Model
OMRON Programmable Multi-Axis Model CK3E-LILI0ON
Controller
OMRON Programmable Multi-Axis Model NY510]-ALICI0O
Controller Industrial Box PC
OMRON EtherCAT Coupler Unit Model NX-ECC203

IE' Precautions for Correct Use

Use model NX-ECC203 Version 1.4 or later for the EtherCAT Coupler Unit.
Models NX-ECC201 and NX-ECC202 cannot be used.
Model NX-ECC203 Version 1.3 cannot be used.

IE' Precautions for Correct Use

In this document, the devices with models and versions listed in Section 5.2 are used as
examples of applicable devices to describe the procedures to connect the devices and check
their connections.

You cannot use devices with versions lower than the versions listed in Section 5.2.

To use the devices mentioned above with models not listed in Section 5.2 or versions higher
than those listed in Section 5.2, check the differences in the specifications by referring to the
manuals before operating the devices.

@ Additional Information
This document describes the procedures to establish the network connections. It does not
provide information on operations, installations, wiring methods, device functionalities, or
device operations, which are not related to the connection procedures. For more information,
refer to the manuals or contact your OMRON representative.



I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this document are as

follows:
Model CK3E-OJOOO

Model NX-ECC203

Windows computer
Power PMAC IDE
Acontis EC-Engineer

Ethernet EtherCAT
e communications communications Model NX-ID3417
Model NX-OD3256

Manufacturer Name Model Version
OMRON Programmable Multi-Axis Model CK3E-L1010 Ver.2.2

Controller
OMRON EtherCAT Coupler Unit Model NX-ECC203 Ver.1.4
OMRON Digital Input Unit Model NX-1D3417 Ver.1.0
OMRON Digital Output Unit Model NX-OD3256 Ver.1.0
OMRON Ethernet cable (with industrial Model

Ethernet connector) XS5W-T421-LIMLI-K
- Windows computer -
DT Power PMAC IDE - Ver.2.2
Acontis Acontis EC-Engineer - Ver.2.4.3

IE' Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

El Precautions for Correct Use

Do not share the connection line of EtherCAT communications with other Ethernet networks.
Do not use devices for Ethernet such as a switching hub.

Use the Ethernet cable (double shielding with aluminum tape and braiding) of Category 5 or
higher, and use the shielded connector of Category 5 or higher.

Connect the cable shield to the connector hood at both ends of the cable.

@ Additional Information
This document describes model CK3E-LICICIC as an example. The same procedures can
apply to model NY510J-ALICIO].

©



6. EtherCAT Connection Procedure

This section describes the procedure for connecting the Controller with the Slave via
EtherCAT. The description assumes that the Controller and the Slave are set to factory

default.

I 6.1. Workflow
Take the following steps to operate the PDO communications via EtherCAT after connecting
the Controller with the Slave via EtherCAT.

6.2 Preparation for the Controller Setup Prepare the Controller settings.
v

6.2.1 Creation of a New Project
v

6.2.2 Initial Settings of the Controller
v

6.3 Installation of ESI Files Install the ESI file for the Slave into
v Acontis EC-Engineer.

6.4 EtherCAT Communications Setup Set up EtherCAT communications.
v

6.4.1 Communications Setup for the EtherCAT Master
v

6.4.2 Distributed Clock Setup
v

6.4.3 PDO Map Settings

v
6.4.4 Creation of an EtherCAT Network Configuration
File

v
6.5 Controller Settings Set up the Controller.
v
6.5.1 EtherCAT Network Configuration Settings
v
6.5.2 EtherCAT Communications Check
v
6.5.3 EtherCAT Variables Settings
v
6.5.4 Writing the User Program
v
6.5.5 Project Data Transfer

10



I 6.2. Preparation for the Controller Setup

Prepare the Controller settings.
Install Power PMAC IDE and Acontis EC-Engineer on the computer in advance.

6.2.1. Creation of a New Project

1 Connect the Controller with the
computer via Ethernet cable.

2 Turn on the power to the
Controller.
3 Start Power PMAC IDE.

* If the dialog for confirming
access rights appears upon

start-up, select starting of
Power PMAC IDE.

4 The Communication screen

appears. Specify the IP address | & Deltz Tau Data Systems Inc. Envimnmen. S |
— e ——__ =
of the destination Controller and Communication | I
|

click Connect. ©=: 4] | |
I IPAddress 192.168.0.200 [=]

* The IP address of the Fort =

Protacal 55H
Controller is set to Uzer root
) ., Pazsward 29999988

192.168.0.200" by default. Apply AllContrals True
SelectDevice AtStartup True

* |f necessary, change the
Windows IP address to

“192.168.0.X". IP Address
Set IP Address

[ Lazt Session ] [ Mo Device ]

Connect

For detailed setup options go to Tools menu -> Options
-> PowerPMAC

11



5 Power PMAC IDE starts, and is

.-‘_ Pawer PMAC Suite (TT9E)

online to the Controller. |
1

: [ Terminal == Position B Watch Wl Status B Jog Ribbon | 4 Communication Setup -
Watch: Onlhinel192.168 0.200:55H] I X

Flla Edit View Project Puld Dabug Tools Delts Tou Window Help

(@ - @K a9 e | b ey x AmycRU

[ 3> ‘PowerPmac (1 70T
Pl Troverrmac(to vevice: |
23 € Language
Ca Configuration
[ Docurnentation
£ Log
(23 PMAC Script Language

i
&

®
W

St X
|| PowerPmac{No Device:) Project Proger
P!
'_ Liser Butfer

> x

-

53
1

18 PowerPMAC Communication Setup

TSz 71 PowerPmac OHFRICHALE LR,

6 From the File menu, select New -
then Project.

% Power PMAC Suite (Administrator)

Edit View Tools Delta Tau Window Help

New 2] Project... Ctrl+Shift+N

a

Open File... Ctrl+N

Close

Project From Existing Code...

Close Solution

Save Selected Items  Ctrl+S

I Save Selected Items As...
Save All Ctrl+Shift+5

Export Template...

Page Setup...

Print... Ctrl+P

H Recent Files

I Recent Projects

Exit

7 Enter a project name and
location, and select OK.

X =l

Preect trpme nBE

Ot Prigect T

e CTacs0
{ocmbnn: | T A LA +| o |
Foktiontage: | [CTacrsienn FF reate drectory br sk {'_‘,r
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6.2.2. Initial Settings of the Controller
Configure the initial settings for the Controller.

IE' Precautions for Correct Use

Configuring the initial settings clears all data in the Controller memory. Back up necessary
data in advance.

In the Terminal pane, type the

$$$*** Command to reset the File Edit View Project Build Debug Tools DeltaTau Window Help
-5 1 | & o5 b Debug -

COﬂtI’O”GI’ to faCtory dEfa‘UIt Watch: Online[192.168.0.200:55H] ~ I > || Position: Onli
Send g;mand Command Response =

L @ SpscvCoumt 85455
[ |EcAT[0]Enable 1
] Slave_0_B071_0_Targettorque  |stdin3:2:armr.. | +

Terminal: Online[192.168.0.200:55H] > 3 x pp_disable.
f#%k
L*L
disab
clear

enabl

|555”*| ]

2 From the Tools menu, select

System Setup to start System e o e

G S e
Setup. _.Turl:ld i_P:r;h:,r. E .. Flat i
| scove
Zend g'jmu Cornrm) = _'e::‘!"#f
Qo ECATIH e [
- ecan W | Mttach to Frocess Claiilt+F
O |ccamm| | Addnvarager.
External Tools:
Cploed, -,
PowerPMAC System Setup T -
starts. '

T p——— AT
okihed

Gume | PUAC g s




3 From the File menu of
PowerPMAC System Setup,

PowerPMAC System Setup : Online[192.168.0.200:55H]

File | Database
select New then Setup. T New y Setup |
Add 3
Save Setup
Restore Setup

4 Specify Servo Frequency.
Global Clock Setting

Select the Servo Frequency
setting from 4 kHz, 2 kHz, or Phase Frequency 1.000 khz
1 kHz.

Servo Frequency (1000 - kiz

* Servo Frequency is set to Detected Servo Hardveare-PWM Frequency

1 kHz for the example in this
document.

5 Click the Accept button. P

Q

v ol
Mewi clock  Pawer PMAC w‘ |

settings Walue
Servo Period (meec) 1000 1000
FhaseChverServoPeriod 1000 1000

Items

No Master Gate detected and No

ETHERCAT option detected

PowerPMAC can be used as a PC using | _
@ software clock. (sys.CPUTimerintr = 1) On|

Acoepting the clock issue save and 555

in the terminal window for changes to

take efiect Check "sys ServaTime’ to

6 If you have changed the servo
frequency setting, type the
SAVE command in the Terminal
pane of Power PMAC IDE.
When complete, the “Save
Complete” message appears in
the Terminal pane.

Terminal: Online[192.168.0.200:55H] ~ 0 X




7 Click Communication Setup

on the toolbar to display the
Device Properties dialog box.

il - G5 e

W Terminal 5 Position [ Watch [ Status G Jog Ri

File Edit View Debug Tools Delts Tau Window Help

won || 4 Communication Setup)

=i

| Watch: offiine -ax T P 2 = R B 4
& Devi roperties S ==}
[t ol
@m_.
W&mﬁmas]:
8 In the Device Properties dialog & Device Properties S =
box, select No Device for IP [ test || [ ey |
Address, then click the Apply
& Device -
button. i ]
Protocal 55H —
Elser ) rfo-l —————— -
This operation sets the 1PAddress
Set IP Address
Controller to the offline state.
o] The Controller restarts.
The servo frequency that has
been set is reflected.
10 Wait until the startup process of
the Controller is complete. Then
click Communication Setup on [ 2 beviee propertes =)
the toolbar to display the Device LoTest | [ ey |
Properties dialog box. 4|
E Device -
In the Device Properties dialog IIHE EH
box, return the IP Address to the | o' S5H N
IP Address

previous setting, then click the
Apply button.

This operation sets the
Controller to the online state.

Set IP Address

15



I 6.3. Installation of ESI Files

Install the ESI file for the Slave into Acontis EC-Engineer.

M Precautions for Correct Use

Prepare the ESI file described in this section in advance. Contact your OMRON
representative for information on how to procure the ESI file.

1 Start EC-Engineer.

£ Power PMAC IDE

el

Nindowes Frolorer 3

N
,'.1,.!3 Paint 3
i

¥ All Programs

| | Search programs and files 2 |

EC ¢ Engineer

Add Waster Unit Getting Started

16



2 From the File menu of EC-Engineer,
select ESI Manager.

The ESI Manager appears.

Network  Settings Help

¥ New Ctri+N
= Open Ctrl+0
H save Cirl+5 _
K save As
Print
gk Add Master-Unit »

ESI Manager

EMLManggar

= Recent Projects »

Exit

Alt+F4

Example of the ESI Manager

= 61 Manager

. —— B ==

E5 Files

.
»

13

P oL Lerze
.

B VIPA Gk
»

Add File Add Falder

Sefect an ESI file which should be deleted or exported or sdd new ESI files,
£ Baumueter Nuemberg GrmbH
B Becknaff Automation Gmbk & Ca, KG

€@ Copiey Cantrols Comp
B0 GMAGN Corparation

¥ vasuawa Dedtric Conporatian

Number of ESI files: 79
Number of devices: 1930 .

Cloge

3 Confirm that Omron NX_Coupler.xml
is registered in the ESI file list of ESI
Manager.

If it is not yet registered, click Add
File and register Omron
NX_Coupler.xml.

| S Files

m ESI Monager -~ Mo

Select an E51 file which should be deleted or exported or add new ESI files.

| b G Copley Controls Com.

b Omran G-Digital 10 smi

|
E|

Add File Add Felder Clese

Number of devices: 1925 r

-
+=* Add ESI File

G-

Organize v New folder

x|
.. « Documents » SystemEsiFiles - || Search SystemEsiFiles 2

=~ 0 @

7 Favorites
B Desktop
18 Downloads

4 Libraries
| Documents

J‘ Music

[ Pictures
B videos

"M Commter

‘5] Recent Places

Documents library
SystemEsiFiles

MName
|£] Omron GX-IC
Al

Arrange by:  Folder =

= Omron NX_Coupler

(=] Omron NAVodules
(2] Omron REED-KMNbox-ECT
2] Omron R88D-KMboo-ECT-L

Z| Omron ZW-7
I YT

- m ]

3

i

File name:  Omron NX_Coupler - ESI Files (*xml) -

4 Click Close to close the ESI
Manager.

17



I 6.4. EtherCAT Communications Setup
Set up EtherCAT communications.

M Precautions for Correct Use

Before taking the following steps, make sure that the devices are connected via an Ethernet
cable. If they are not connected, turn OFF the power to the devices, and connect the Ethernet

cable.

6.4.1. Communications Setup for the EtherCAT Master

1 Connect the Controller with
slave devices using an Ethernet
cable.

* Refer to the manuals for slave
devices to configure them.

k. Gettings  Help

2 Display Start Page of

& Configuration Hode, IS R Diognosis Mode

EC-Engineer, and select :
EtherCAT Master Unit (Class TR
A) from Add Master Unit. - EC #Engfneef

Getting Started

|| Classic view |Flat View | Topology View

3 Class-A Master is added to the
Project Explorer.

18



4 In the Master page, specify a
communication period for Cycle
Time [us].

* You must specify the
communication period in
accordance with the servo
frequency of the Controller.
1000 us is set in this document.

= EC-Engineer [-]

[ wew petwork  gemngs  peip
£ Configuration Mode SR . Diagnarsis Mode

Marster

General

l Cyde Time [us) 1000 I

Correspondence between the servo frequencies of the
Controller and communication periods is as follows:

4 kHz : 250 us

2 kHz : 500 us

1 kHz : 1000 us

5 In the Master page, set the IP
address of the destination
Controller in IP Address, and
click the Select button to apply
the setting.

* Default IP address
“192.168.0.200" is specified in
this example.

* Do not select Slaves
connected to local system as it
is not used.

Master

General
Unit Nama Class-A Master
Cycle Tirne [us] 1000
Source MAC address

Slaves connected to local system
feemacc.Adoptes: O—#5 TUFEHE { Intel(R) Ethernet Connection 1217-LM )

Slances connected bo remabe system
I“"'“ddrss 192.168. 0 200 I

L2itali]

: |
B -

6 Right-click on Class-A Master
in the Project Explorer, and
select Scan EtherCAT Network
from the menu.

= EC-Engineer [--]

File View MNetwork Settings Help

£ Configuration Mode ™| B Diagnosis Mode
- Class-A Maf:rpr Master |
Scan EtherCAT Network
s Append Slave General
Unit Name
® Remove Master-Unit Cycle Time
Source MAC
Slaves conmn¢
= Import Slaves from ENI File Network Ad

# Change Master Unit

19



7 Make sure that the slave is
displayed in the Project
Explorer.

[ |
# EC-Engineer [C:‘\-N_IPCLH,Dumm

File View Network Seftings Help

. Configuration Mode [l 125 uda!
Project Explorer

v [TCIETETTEET
B Slave 1001 [NX-ECC203] (1001) |
B 001 Module 1 (NX-ID3417)

B 002 Module 2 (NX-OD3256)

k4

6.4.2. Distributed Clock Setup

1 Setting Distributed Clocks (DC)
for Master

In the Project Explorer, select
Class-A Master to display the
Distributed Clocks tab page.

B Diagriosis Mode

Devace Editor
Master | Process Data Image | Variables | Advanced Options | Slave td
Slave_1001 [NX-ECC203] (1001)
B 001: Module 1 (NX-ID3417) Referanes Gack
B 002 Module 2 (NX-0D3256) Name M tlave with sctivated OC in configuration
Chock Adjustrment

@ Master Shift (EtherCAT Master Time controlled by Reference Clock)
Bus Shift (Reference Clock controlied by EtherCAT Master Time)

Optians

Continuous Propagation Compensation
Sy Wirdow Monitoring
Show 6481t System Time

* |f the Distributed Clocks tab does not appear, select View
then the Expert Mode check box.

p
= EC-Engineer [--] .

File Network  Setting
Messages
<

Short Info
Projes
Expert Mode

r Refresh F5

2 Select Master Shift (EtherCAT
Master Time controlled by
Reference Clock).

[Ep—— B Giogress o

| L Classd Master Master | Process Data Image | Variables | Advanced Options | Slave to Slave | Distrbuted Clodks | My
* [l Slave_1001 [NX-ECC203] (1001} o .
B 001: Module 1 (NX-ID3417) S
Name

B 002 Module 2 (NX-0D3256) No slave with activated OC in configuration

& Master Shift (EtherCAT Master Time controlied by Reference Clock)
Ww "

Options.

Continusus Propagation Campensation
Sync Window Monitaring
Show 648/t System Time

20



B When using in DC mode

Setting Distributed Clock (DC)
for the Slave

In the Project Explorer, select
the target slave to display the
Distributed Clock tab page.

Device Editor
General | Madules | PDO Mapping | Variables | Advanced Options || Distributed Clock flr

- —— Distributed Clock
H 002 Madule 2 (NX-003256) Cperation Mode DL for synchronization
Sync Unit Cycle {us) 1000

Overwrite Mode I+

4| Sync Units
4 Syne Unit 0
Cycle Time
® Syne Unit Cycle x1 1000 us
User defined 1000
Shift Time (us) 500

4 Select the Overwrite Mode
check box and specify Shift
Time.

File  View Network Settings  Help
bl Eponent B Diagnosis Mode
L Class-A Master General | Modules | PDO Mapping | Variables | Advanced Options | Distributed Clack |Io
- |—.
m— Distributed Clock
B oo :
B 002 Module 2 (NX-0D3258) Operation Mode D for gyrchronization
I Overarite Mode = I
4| Sync Units
) Syme Unit 0
Cyele Time
@ Syne Unit Cycle T 1000 us
I Shift Time (us) 500 I

Correspondence between the servo frequencies of
the Controller and Shift Time values is as follows:
4 kHz : 125 us

2 kHz : 250 us

1 kHz : 500 us

21



B When using in Free-Run mode

Setting Distributed Clock (DC)
for the Slave

In the Project Explorer, select
the target slave to display the
Distributed Clock tab page.

File  View Network Settings Help
el Export EN1 I Diagnosis Mode
= Device Editor
General | Modules | PDO Mapping | Variables | Advanced Options

o plager

Distributed Clock fir

Distributed Clock
Operation Mode DX for synchiranization
Sync Unit Cycle {us) | 1000
Overwrite Mode e

W 002 Module 2 (NX-OD3256)

-/ Syne Units
[ Syme Unit 0
Cyele Time
@ Syne Unit Cyele 1 1000 us

User defined 1000}
Shift Time (us) 00|

Select FreeRun from the drop
down list for Operation Mode.

_ — — —
= EC-Engineer [—] — VG 8V _ | w—

File View Network Settings Help

I Sync Units

£ Configuration Mode ™ = dyd= 1 |88 Diagnosis Mode

Project Explorer Device Editor
- General | Modules | PDO Mapping | Variables | Advanced Options | Dist

B Slave_1001 [NX-ECC203] (1001) —
Distributed Clock

: Module

§ 002: Module 2 (NX-0D3256) Operation Mode
Sync Unit Cycle (us) DC for synchronization

Overwrite Mode

DC with priority in cycle time

I Sync Unit 0

Cycle Time

(O Sync Unit Cycle x1 Ous

() User defined

L

Shift Time (us)

| Classic view |Fiat view | Topology view | Sync Unit 1

5 Display the Advanced Options

tab page.

Clear the Potential Reference
Clock check box.

|| Fiie  View Network Sattings  Help

Configuration Mode [l S 12t B Diagnosis Mode
v L Class-A Master .Grncrall [oe] Mappingl \-'nrinblts| Advanced Options | Init Commands
* | I Slave 1001 [NX-ECC203) (100L) Disable LRW

B 001: Module & (NX-ID3417)

W 002 Module 2 (NX-0D3256) Overwrite Watchilog
[¥] Set Multiplier (Reg. 0x400): 21D
Sat POl Watchdog (Reg: Dud10): 1000 E31100.000 )
[#] Set SM Watchdog [Reg. 0xd20) 1000 E(LGCI.DDD ms)

Distributed Clocks

|| Potential Reference Clack

22



6.4.3. PDO Map Settings

1 In the Project Explorer, select
the target slave to display the
PDO Mapping tab page.

View

MNetwork  Settings  Help

B Dizgnosis Mode

General | Modules | PDO Mapping | Variables | Advanced Options

- lnpuls
B 002 Module 2 (NX-0D3256) v [¥ 505th transmit PDO Mapping ow1BFg |~
Name Indiex Bit Length |
NX Uit Ragistratic | 0x3003:03 &
X Unit 1O Data /  (h3006:03 E4
w [ 512th transmit PDO Mapping Ox1BFF |
Name Index Bit Length
Sysmac Error State | x2002:01 B
v [V]| 5015t transmit PDO Magping aasFa |
Mame Index Bit Length
B
g Module 1 (NX-ID3417)dnput Data Set 1

Ox1ADD

Setting PDO mapping (Inputs)

2 Inputs
v :4'- ISﬂ'E-I:h transmit PDO Magoing | Ca1BFE '
Confirm the check boxes in the RS s Bit Length
Inputs field. NX Unit Registratic 0x3003:03 &4
MX Unit 1O Data £ On3006:03 E=
* If you do not want to use data Bl B3| s trmnie $00 Magsping sase 13
in the Inputs field, clear the Nama Index Bit Length
currently displayed check Sysmac Ermor Stat, | (x200201 B
boxes. v [#] 501sttransmit PDO Mapping Ge1Fe
Mame Index Bit Length
B
- Module 1 (NX-ID341TImput Data Set 1 OxlADD
3 Setting PDO mapping (Outputs) Outputs
. b Modute 2 (MNX-0D3Z56.0utput Data Set 1 Owl604
Confirm the check boxes in the e e Bit Length
Outputs field. Gl WD A0 ¢
* |f you do not want to use data
in the Outputs field, clear the 1
currently displayed check * MadueAllgnPDO Ox17F6
boxes. MName Index Bit Length
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6.4.4. Creation of an EtherCAT Network Configuration File

1 Click Export ENI on the upper .. ec-engineer [--]

part of the EC-Engineer page. File View MNetwork Settings Help

“£ Configuration Mode || = Export ENI B8, Diagnosis Mode

2 Enter a file name, and then |4 Export EtherCAT-Network-Information (ENI) File
—
CIle Save to Create an mv . v Computer » Local Disk (C) » tmp Search tmp
EtherCAT network Organize = Mew folder ;
. . . & local Disk () *  Name Date modified
configuration file. | DeltaTau
| inetpub Mo items match your search.
. Intel
. OE-Downloade—,
. Omren L
./ Perflogs 1

.. Program Files
. Program Files

L tmp

-~ 4 .

Type

I File name: m

Save as type: [EtherCAT-Network-In' ‘ormation (EMI) Files (*xml)

# Hide Folders | Save

Cancel

I 6.5. Controller Settings

6.5.1. EtherCAT Network Configuration Settings

1 From the Tools menu of Power e T —
PMAC IDE, select System M i S
. B Hardmarn Dispross: ——
Setup to display System ¥ Ioain EtherCAT. ™
EtherCAT License Status: EherCAT 10 Desices Licenss Only
Setup. -
ster type: ACONTIS
Bomin o ori B (Browse | [ Downicsd ENitie
2 Click Browse, and load the & PomerPHAC Spta St | Ol i52.1680.200 554 T ]
File Database
EtherCAT network configuration ||« s EtherCAT™
. . . a3 Mowrs &
flle Created In 6.4.4 Creatlon Of N EtherCAT License Status: EherCAT 10 Desices Licenss Only
an EtherCAT Network EberCAT Masterpe: ACONTIS
Configuration File. T T

3 Click Download ENI file to
download the EtherCAT EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only

network configuration to the
Controller.

EtherCAT Master type: ACONTIS

Browse to eni file
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6.5.2. EtherCAT Communications Check

Take the following steps to ensure that EtherCAT communications are available.

1 From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

Terminal: Online[192.168.0.200:55H] - 01 X

ECAT[0].Enable=1

2 In the Terminal or Watch pane, Watch: Online[192.168.0.200:55H] +IX
make sure that the Send g:mand Command Response
ECAT[0].Enable value turns to 1. a P PRI

ECAT[0].Enable 1
* The OP mode is entered and B ECATIO].Error s0
EtherCAT communications are L_J
established.

3 After making sure that correct Watch: Online[192.168.0 200:55H] S
communications are available, Send g;mand Command e
run the ECAT[0].Enable=0 O e
command from the Terminal pane ECATIO] Enable 1
to stop EtherCAT I ECATI0] Error 50
communications. ==

| Terminal: Online[192.168.0.200:55H] ~ 01 X

ECAT[0].Enable=0

4 In the Terminal or Watch pane,

Watch: Online[192.168.0.200:55H] ~ 0 X
make sure that the On
Send D d Command Rezponse
ECAT[0].Enable value turns to O. L
Sy Soran o0t 1252074
ECAT[0] Enable 0
ECAT[O].Error 50




6.5.3. EtherCAT Variables Settings

1 In the System Setup page,
right-click on
Master[0].Deactivated to display
the pop-up menu, and select
Export EtherCAT Variables.

PowerPMAC Systemn Setup : Online[192.168.0.200:SSH]

File  Database

(=] 5? Power PMAC (192.168.0.201

el

EtmerCAT.
L]

rt EtherCAT Variables —————————

TUMTETGHT CICETTS e OTaTrs. LtITErCAT 10 Device

EtherCAT Master type: ACONTIS

.
Enter a name for the EtherCAT e
2 ) o ) O - ¥ vocumers »
variable definition file for user —
Organize New folder
programs |nt0 the root Of the /¢ Favorites Name Date modified Type Size
Bl Desktop Bin 7/8/2016 8:42 PM File folder
H & Downloads C Language 2016 8:42 PM File folder
prOJeCt fOIder' £l Recent Places Configuration 2016 8:42 PM File folder
Documentation 2016 8:42 PM File folder
w4 Libraries L Log 2016 8:42 PM File folder
[ Documents. 1 PMAC Script Language 7/8/2016 8:42 PM File folder
o Music
[=] Pictures
B videos
% Computer =
&, Local Disk (C)
File name: ECAT)Janab\asJ 4
Save a3 type: | ppmac header files (*.pmh) M

The created EtherCAT variable
definition file is added to under
Global Includes of PMAC Script
Language in Solution Explorer.

Velocity: Online[19

. & X | Following Error: Onli.. » & X | [Solution Explorer - Solution .. + &

| =

[5] Selution "PowerPmac’ (1 project

£ [ PowerPmac2({192.168.0.200
- [ Clanguage

[ Configuration

[ Documentation

] Log

- [z PMAC Script Language

ecat_variables.pmh

ecat_variables

- [ZZ Global Includes

El] ==t variables.pml

#define Slave 0_3220_1_OutputBit00
#define Slave 0_3220_2_OutputBitol
#define Slave_0_3220_3_OutputBit02
#define Slave 0_3220_4_OutputBit03
#define Slave 0_3220_5_OurputBit04
#define Slave 0_3220_6_OutputBit05
#define Slave 0_3220_7_OutputBit0é

ECAT[0].IO[0].Data
ECAT[0].IO[1].Data
ECAT[0].IO[2].Data
ECAT[0].IO[3].Data
ECAT[0].IO[4].Data
ECAT[0].IO[5].Data
ECAT[0].IO[6].Data ]

|

3 Kinematic Routines
- [ Libraries
&+ 4 Motion Programs
& [ PLC Programs
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6.5.4. Writing the User Program

Create programs to be used to check operations.
A specific language is used for the operation check programs. Refer to Power PMAC User’s
Manual and Power PMAC Software Reference Manual for details.

1 In the Solution Explorer pane,
open Project name — PMAC
Script Language — PLC
Programs —plcl.plc.

w By CPY = | % 1200 = | 3 .Tqrn-.r.gl
arer - Soktion

nln.. = 3 ¥ || Velookyt Online.. = 3 ® || Followisg Eron.. = 3 X | | Sohstson Exple

pR_tushim_iaeatpl
A pp_ssablete
| pp_inc_disabbete
5] ppoinc_startuptet
PR tnan.ely
5] pp_startupcba
s Documemation
< Leg
L PMAL Senpt Lenguage

miyecat.olp | ecatactivateloly | 2015102800 | 20151008 pmb =

o Globel Inchades
51028 pmb
gebal defnmiani.prh
J Kinematic Routines
& L Litwanes
- [ Mstion Programs

Propedied

" ||| ecatsctivatelloly Fie Properties

7 (&1

2 In the programming area of the
plcl.plc tab page, write a
program as show on the right.

This sample program blinks the
NX-OD3256 output indicator
every second.

* In this example, PDO mapping
is assumed to be the default
setting. If you want to change
PDO mapping, rewrite the
“Slave_0....” description.

open plc 1
while(sys.ecatMasterReady==0){};
ECAT[0].Enable=1;

P1000=Sys.Time+1;
while(P1000>Sys.Time){};

Slave_0_7020 2 OutputBit0l = 1;

P1000=Sys.Time+1;
while(P1000>Sys.Time){};

Slave_0_7020_2_OutputBit01 = 0;

close
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3 Setting the start of the user -

program ndow  Help
tbug  Any CFU | [ a0 ~ |5 = | Terminal
= a 3 Sohsion Erpleter - Schation = 3 ¥

In the Solution Explorer pane,
open Project name —
Configuration —

0L A0
PR progh
i Libwarnes
% 3 Resitime Eputires

2 Configusation

pr.disable.txt | myecat.cig| ecatactivated.clg | 201510780 b

pp—dlsabletxt Ok o /FEill all the morora (This cprioel » wam.“‘_ﬂhlq

EA ffaEssT ALl

disable ple 0..31
clear all buffers

enakble ple 1

pp_sarvecly
3] pp tseiapin
& [ Documentation

&  Leg

.- Pp_disable twt File Propeties
sl

4 In the programming area of the
pp_disable.txt tab page, add the enable plc 1;
program shown on the right to
the last line.

The pp_disable.txt program is
automatically executed when the
Controller starts.

This example program runs the
PLC1 script.

6.5.5. Project Data Transfer
Transfer the created project data to the Controller.

/A WARNING

When the user program and “configuration and setting” data are transferred from
Power PMAC IDE, devices or the machine may perform unexpected operations.
Therefore, before you transfer project data, ensure the destination slave is
operating safely.

Transferring project data restarts the Controller and interrupts communications

with slaves. The time that communications are interrupted depends on the
EtherCAT network configuration.

Before you transfer project data, make sure that the slave settings will not
adversely affect the devices.
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1 In the Terminal or Watch pane,
make sure that the
ECAT[0].Enable value is 0.

If the value is 1, run the
ECAT[0].Enable=0 command
from the Terminal pane to stop
EtherCAT communications.

- Power PMAC Suite (Administrator)

File Edit View Project Build Debug Tools DeltaTau V

G- - O el i | % B3 @9 -0 S [

hoar | EEE|E 2O 103 & B
@ Terminal 4 Position [Z] Watch |8 Status @ Jog Ribbon | < ¢
Watch: Online(192.168.0.200:55H] ~ 1 x
Send g;mand Command Response
1 | |ECATIOlEnable 0

#1- Make sure that ECAT[0].Enable=0

Terminal Online[192.168.0.200:55H]

2 Downloading a project

Right-click the project name in
the Solution Explorer pane on
the upper right of the IDE
screen, and select Build and
Download All Programs to run
the build and download.

Solution Explorer - Powe... » 0 ¥

=

(oA Solution 'PowerPmac_ECC201+S
=*m | PowerPmac_ECC201+5afe
= [ C Language i | Build
+ [ Background H Clean
+- [3 CPLCs
w1 (3 Include Debug
i [ Libraries Build and Download All Programs
i #- [ Realtime RdY Download All Programs
+- [ Configuration
) Map PMAC Variables
+- [ Documentation
#- £ Log Add Macro Project
#- £ PMAC Script Lan % | cut
* | Remove
Unload Project
1 LilJ i | Properties
Properties >~ I'X ] r

3 Make sure that there are no
errors in the Output tab page.

* |If the transfer fails, check
details of the error in the Output
tab page.

If the error is a program error,
you must review the program.

If the error is related to
EtherCAT settings, return to
System Setup and check
whether there are any incorrect
settings.
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4 The program starts running
when it has been downloaded Terminal: Online[192.168.0.200:55H]
successfully.

EtherCAT communications are
in the OP state. Make sure that

|er|ab|e plc1

the NX-OD3256 output indicator
blinks.

* If the indicator does not blink,
check that the ECAT[0].Enable
value is 1 in the Terminal or
Watch pane.

If the value is 0, run the following
command from the Terminal
pane.

enable plc 1

5 After you have confirmed an Terminal: Online[192.168.0.200:55H]
appropriate operation, save the |EEitaEg
project to the Controller.

ave
Run the save command from the 's—l
Terminal pane.

* The transferred project is not
yet saved to the Controller at
this stage.

If you turn OFF the power to the
Controller, the transferred
project will be discarded.
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7. Appendix

Saving and Loading a Project

The following describes the procedures to save a Power PMAC IDE project on the computer, and to

reuse it.

I 7.1. Saving a Project

1 Creating a Configuration File

Create a Configuration File to
save parameters you have
changed in System Setup to the
project.

Right-click Configuration in the
Solution Explorer pane, and
select Generate Configuration
File.

A Configuration File is added to
Configuration.

- DDJ:IFDj.h
----- 1 Libraries
[+ [ Realtime Routines
) Configuratize

Add

] i Properties

Upload Config Files
Download Config Files

Generate Configuration File

- [ Documentation

Lpra 11 Aam

Right-click on the Configuration
File, and from the menu, select
Check To Download Config File
to include it in files to be
downloaded.

. Configuration

m

g Open With...

View Code

[i]

Exclude From Project
= )( Delete

", n Rename
Check To Downlead Config File

‘= | Properties

Saving a Project

In the File menu, run Save All to
save the project on the computer.

<+ Power PMAC Suite

Edit  View
New
Open
Add
Close

1 | Close Solution

Upload Projec!

|l | Save uPowerP

Save uPowerF

i@ Save Al
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I 7.2. Loading and Downloading a Project

Start Power PMAC IDE, and
connect to the Controller.

In the Terminal pane, type the
$$$*** command to reset the
Controller settings to factory
default.

Terminal: Online[192.168.0.200:55H]

In the File menu, Click Open —
Project/Solution to load the
project that you saved.

<+ Power PMAC Suite (Administrator)

Edit View Tools Delta Tau Window Help
New [3 t - =

||

Any CPU

|D€L‘,Lg v‘

¥ | @1 Project/Solution... Ctrl+Shift+0

Ctrl+0

& | File... Velocity:

Response

0177640

Page Sel
Pri +P
Recent Files 4
Recent Projects 3
Exit
4 From the TOOIS menu Of Power PowerPMAC System Setup : Ondne{192.168.0,200:55M] 1 (2]
File Database
PMAC IDE, select System Setup  E e —
to display System Setup. ) i Coames S SASCA 10 Do
EtherCAT Master ype: ACONTIS
Browse to eni fils Browse Duwnivad ENI te
Click Browse, and load the ENI e
EtherCAT.

file that you created in 6.4.4
Creation of an EtherCAT Network
Configuration File.

EtherCAT License Status: EtherCAT IO Devices License Only
EtherCAT Master type: ACONTIS

| Download ENI file |

Browse to eni file

Click Download ENI file to
download the EtherCAT network
configuration to the Controller.

—
EtherCAT.

EtherCAT License Status: EtherCAT IO Devices License Only

EtherCAT Master type: ACONTIS

B{M

Browse to eni file

32



7 Right-click Configuration in the
Solution Explorer pane, and
select Download Config Files to
download the file to the Controller.

Solution Explorer - Solut... » 10 X

=]
- &= Include

i [] 20160204.h
[ pp_proj.h
.. 1 Libraries

=Rlfi=] Configuration
- |_| ecatactivg
|| myecat.cf
- || pp_custon

| pp_custon

+- [J Realtime Routines

-

Add »
Properties

Upload Config Files

- |2 pp_disablg

Download Config Files

- 2 pp_inc_dis

Generate Configuration File

- |2 pp_inc_stz.
| pp_save.cfg
- 2] pp_startup.ixt

=

J

8 Right-click the project name in
the Solution Explorer pane, and
select Build and Download All
Programs to run the build and
download.

When the download process is
complete, make sure that there

Solution Explorer - Powe...w» I

‘=

X

[54 Solution 'PowerPmac_ECC201+5

=Mm| FowerPmac_ECC201+Safe

- 3 Background A
- [ CPLCs

= [&F C Language ]

Build
Clean

Debug 4

Build and Download All Programs

+- [ Configuration
#1- [ Documentation

Download All Programs

Map PMAC Variables

are no errors in the Output tab 3 [ Log e
+-- [ PMAC Script Lan & | cut
page. x
Remowve
Unload Project
1 L[} = | Properties
Properties - 1I'X l r
O Stopping a program Terminal: Online[192.168.0.200:55H] ~ 0 X
If a program is running, execute I
the following command from the
i |disable ple 1
Terminal pane to stop the
program.
disable plc 1 Terminal: Online[182.168.0.200:55H] ~ 0 X

ECAT[0].Enable=0

”EDAT[IJ].EnabIe=D
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10

Saving the downloaded settings
and programs

After the download process is
complete and you make sure that
there are no errors in the Output
tab page, run the save command
from the Terminal pane.

* The save command stores the
downloaded project in the
Controller. This operation saves
the settings to be executed
automatically when the power to
the Controller is turned on.

Terminal: Online[192.168.0.200:55H]

Save Complete

}SEVE

11

Restarting after download

Run the following command from
the Terminal pane to restart the
Controller with the downloaded
project.

$$3$

Terminal: Online[192.168.0.200:55H]

”555
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8. Appendix Troubleshooting

8.1. Factors Causing EtherCAT Communications To Be Unavailable, and
Corrective Actions
Description Factor Corrective Action

The link is not established.

The Ethernet cable is broken or
the specified cable is not being
used.

If the Ethernet cable is broken
or if the specified cable was not
used, replace the cable.

A connector on the Ethernet
cable used for EtherCAT
communications is
disconnected, the contact is
faulty, or parts are faulty.

Reconnect the connector and
make sure it is mated correctly.

A slave within the EtherCAT
network configuration failed.

Replace the slave.

EtherCAT communications do
not start.

ECAT[0].Enable is set to 0.

From the Terminal pane, run the
ECAT[0].Enable=1 command to
start EtherCAT communications.

The EtherCAT network
configuration in the Controller
does not agree with the
physical network configuration.

Review the settings according
to the procedures provided in
6.4 EtherCAT Communications
Setup.

The Ethernet cable is broken at
a slave in the network, or a
connector is disconnected.

Connect the Ethernet cable
correctly.

Some errors have occurred,
and the ECATJ[O].error is setto a
value other than 0.

Check the ECAT]O].error value.

A synchronization error occurs
at a slave.

The distribution clock is not set
correctly.

A slave in Free-Run Mode is set
to the reference clock.

Review the settings according
to the procedures provided in
6.4.2 Distributed Clock Setup.

The servo task processing time
exceeds the set period.

Review the program or servo
frequency to adjust it, so that
the servo task processing time
does not exceed the period.
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I 8.2. How to Check for Errors

8.2.1. Checking the EtherCAT Status
You can check the EtherCAT status from System Setup of Power PMAC IDE and Diagnosis Mode
of Acontis EC-Engineer.

B System Setup of Power PMAC IDE
You can check the status of the EtherCAT master and slaves in the System Setup page of Power

File  Database

549 PowerPMAC (192.168.0.200)
¢ s Hardware Diagnosis

4 Motors

YY) ctcr{0] Activated

—
EtherCAT.

EtherCAT License Status: Mo License

EtherCAT Master type: ACONTIS

C\U=sers\OMRON_IPC_1\Desktopleni.xm!

[Browse| [ Download ENIfile
STave status
ECAT[®].5laveCount=2 B Mo Status Emor  Description
ECAT[@].TxTime=3
ECAT[®].RxTime=1 0 o] Mo Slave_1001 [GX0D1611]
BERE L= D e 1 oP No | Slave_1002 [GX-MD3218]

B Diagnosis Mode of Acontis EC-Engineer
You can check the status of the slaves in the Diagnosis Mode page of Acontis EC-Engineer.

i B EC-Engineer [__]- _\E@lﬂﬂ

|| File

View

Network

#. Configuration Made

Settings

m

Help

[ Diagnosis Mode

Project Explorer
v @ Class-A Master <connected>
| o Slave 1001 [GX-0D1611] (1001) |
@ Slave_1002 [GX-MD3218] (1002)

Device Editor
General |'\-"ar|'ables || ESC Register ” EEPROM || Extended Diagnosis " DC Diagnosis ” CoE Q[4][]

State Machine

Current State |0p
Requested State |0p
Init
Change State Pre-Op Safe-Op
Error State
Current No error
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Select Network then Network Mismatch Analyzer from the menu to verify the network configuration.

-

= Network Mismatch Analyzer

m@ﬂ

List of slaves

Name Configured Slave
Slave_002 [R3& | R88D-KNO1L-ECT [2]

Slave_003 [R8S | RESD-KND1L-ECT [3]

0x00020001 0

Please, compare the configured slaves with the connected slaves. If something is red, you have a
netwaork configuration mismatch!

Revision Alias | Network Slave

0x00020001 | O

Revision Alias

REBD-KNO1L-ECT [2] | 0x00020001 | 1

Close

8.2.2. Checking the Controller Status
In the Status page of Power PMAC IDE, you can check the status of the motor, coordinate system,

and system.

To display the Status page, click Status on the toolbar.

M Global Status

You can check system errors such as the WDT error.

Status: Online[192.168.0.

Motor Status ] Coordinate Status

Global Status

Description

BufSizeErr
ConfigloadErr
Default
FileConfigErr
FlashSizeErr

Status

AbortAll False

False
False
False
False
False

MACRO 5tatus ] ECAT Status ]

Description
HWCha-ngeErr
MoClocks
ProjectLoadErr
PwrOnFault
WD TFault

Status
| i:alse
False
False
False
MNoFault
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Bl Motor Status
You can check deviation errors, limit errors, and other states of the motor.

Coordinate Status] Global Statusl MACRO Status l ECAT Status ]
Motor 0 = ® Motor not activated

| Description Status Description Status
_ False IZtFauIt. i:alse
AmpFault False InPos False
AmpWarn False LimitStop False
AuxFault False MinusLimit False
BIDir Plus PhaseFound False
BlockRequest False PlusLimit False
ClosedLoop False SoftLimit False
Csolve False SoftLimitDir Plus
DacLimit False SoftMinusLimit False
DesVelZero False SoftPlusLimit False
Encloss False SpindleMotor False
FeFatal False TraceCount 0

| FeWarn False TriggerMove False

| GantryHomed False TriggerMotFound False
HomeComplete False TriggerSpeedsel MaxSpeed
HomelnProgress False

B Coordinate Status

You can check deviation errors, limit errors and other states of the coordinate system.

Status: Onling[192.

SSH]

Motor Statu CDDn:ImateStatu] Global Status] MACRO Status l ECAT Status ]
Coordinate System 0 =
Description Status Description Status it
|AddedDwelbis IS LinToPviBuf False
AmpEna False LookAheadActive False
AmpFault False LookAheadChange False
AmpWarn False LookAheadDir Forward
AuxFault False LookfheadFlush False
BlockActive False LookAheadlookBack False
BlockRequest False LockAheadReCalc False
BufferWarn 0 LockAheadStop False
CC3Active False LockAheadWrap False =
CCAddedArc False MinusLimnit False i
CCMode Off MovelMode LineCircle
CCMoveType Dwell PlusLimit False
|| CCOffReq False Proghctive False
| ClosedLoop False ProgProceeding False
ContMotion False ProgRunning False
Csolve False SegEnabled False
DesVelZero False SegMove Off
Encloss False SegMovelccel False
EndDelayActive False SegMoveDecel False B
ErrorStatus MoError SegStopReq False
FeedHeld Off SharpCornerstop False
FeFatal False SoftMinusLimit False
u‘-’am False SoftPlusLimit False
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9. Appendix ECAT]Ji] Structure Elements

The Controller uses motion controller technology developed by Delta Tau Data Systems, Inc.,
(hereafter referred to as DT) in the U.S., however, the ECAT]i] structure elements differ from those of
DT controllers. The following table shows the major changes that have been made from DT

controllers.

Element name

Description

Change

ECATI[i].Enable

ECATI[i].LPIO[K]

ECATIi].Slave[j]
ECATIi].Error

ECAT]Ii].LinkUp
ECAT[i].LPDomainOutputState
ECAT[i].LPDomainState
ECAT[i].LPRxTime
ECAT[i].LPTxTime
ECAT[i].MasterStat
ECAT[i].RTDomainOutputState
ECATIi].RTDomainState

Enabling the EtherCAT
network

Elements of low priority
I/0O module

Slave elements

Error code of enabling
EtherCAT network

Status data structure
elements

0: Disable, 1: Enable
(2 and 3 are not supported.)
Not supported

Not supported

$ 9811000C: Invalid network
configuration

$ 9811002E: Disconnected network
connection

Not supported
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10. Revision History

Revision Revised date Revised content
code
A May 18, 2016 First edition
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